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Installing WordMill

Generally
WordMill may be installed in a stand-alone or networked configuration.  The program is
network-ready, and is able to keep track of multiple users at the same time.  The WordMill
Library and associated software can be installed from the internet, at
http://www.courtforms.com, or from a WordMill CD-ROM or from installation diskettes.

WordMill ver. 2 requires a computer running Windows 3.1 or higher.  WordMill ver. 3
requires a computer running Windows 95 or higher.  In other words, any modern PC can
run WordMill!

WordMill relies upon Windows to provide printer compatibility and selection.

WordMill has been designed with a reference code and matching key word procedure
which will prevent unregistered users from printing official documents.  The key word the
user will receive is specific to the computer that generates the reference code.  Registered
users may obtain the key word by calling WordMill at 1-800-967-3645.  Unregistered users
who wish to purchase the software may call the same number to purchase the software.

To install the WordMill Library complete the following steps:

Normal installation
1. While in Windows environment, insert WordMill CD-ROM into CD drive

2. The installer should launch automatically.  If it doesn’t, open the drive containing
the CD-ROM and start the ‘install’ application.

3. Follow the setup instructions on the screen.

4. Find and click on the appropriate WordMill icon to start WordMill.

5. The WordMill program will provide the user with a reference number and will
require the user to enter a key word for each installation.  Obtain the key word by
calling WordMill at 1-800-967-3645.  Please have the reference number(s) when
you call.

Network installation
WordMill may be installed on a network.  WordMill must be installed and run from each
client machine and the server should be the repository of the shared data.  WordMill
requires the following configuration of its files for network installation.

WordMill.exe and related files provide the programming mechanics required to run the
system.  These files must be located on each client hard disk.  WordMill.exe is not required
on the network server.

Note:  The user must allow the setup program to install the various WordMill files
and create the program icon(s).

Form libraries are stored in the file named after the library and followed by the
".wml" suffix. Example: "USDC.wml."  These files provide the templates for the forms in
the library and  must also be located on each client hard disk.  The library files are not
required on the network server.

Data applications
(*dat.wml) may be
used as  server data
files.

WordMill data files are named after the library followed by
"dat.wml". For example, the data file for the USDC library is
USDCdat.wml  These files provide the structured storage file for
the case data which is used to complete the forms.  -----dat.wml
files may be moved to any location required by the user.  These
files may also be shared by more than one client.  The -----
dat.wml files are required on the network server.

Perform the following to install WordMill on your network.
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1. Install WordMill on all clients using the stand-alone installation steps described
above.

2. Move a copy of the -----dat.wml file onto the server drive in any desired location,
for instance f:\data\wordmill\usdcdat.wml.

3. Find and click on the appropriate WordMill icon to start WordMill.

4. WordMill will detect that the connection between the program and -----dat.wml has
been severed and will prompt the user to enter the correct path to usdcdat.wml.

5. Browse to the path of the server, such as f:\data\wordmill\usdcdat.wml.

The WordMill Client is now connected to the WordMill Server File.
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Using WordMill

Generally
Wordmill is designed to provide many valuable tools to legal practitioners and their support
staff.  A brief explanation of the structure of the WordMill system will help the user take
advantage of the capabilities built into WordMill.

WordMill "thinks" in
terms of collecting
case information and
using that information
to produce forms.

WordMill approaches form files in a manner quite different from
that of a typewriter or even a word processor.  It saves case
data separately from the form layout data, and inserts that data
into the forms when required by the user.  As such it is
important to think in terms of entering and saving case data
when using WordMill, and not in terms of typing a cover sheet
or saving a subpoena.  Entering data into a cover sheet is
essentially also entering that same case data into the summons
and subpoenas or other documents which will be required
during later stages of the proceeding.

This distinction requires the user to decide whether a form is related to a case with records
already entered into WordMill or whether this is the first time the system is being used on a
particular case.

WordMill uses the standard Windows conventions, and many of the Windows functions
such as Cut (ctrl-x), Copy (ctrl-c) and Paste (ctrl-v) are available through the standard
hot-keys.  Many WordPerfect keystrokes are also duplicated in WordMill.  The user should
be able to use WordMill without formal training; however, a quick inspection of the following
topics will be of value.

The following manual describes the WordMill functions in the order in which they will be
used.

WordMill On-Line Help
Help is provided for all libraries.  Access Help by pressing the F1 key at any time, or by
selecting Help from the Help menu item.
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How To...

Open WordMill
Click on the WordMill icon to begin a WordMill session.  After the opening screen and the
key commands, the following screen will appear:

List of forms

Option buttons

Select WordMill Forms Screen

The screen presents the user with a list of all forms available in the library and function
buttons which will be described below.

Open a form related to a new case

Check the box
next to the form
you wish to open.

Select the Load
New Form button

To create a form related to a new case perform the following:

1. Open WordMill from Windows, or close all open WordMill forms (if any).

2. Check the box adjacent to the desired form in the Select WordMill Forms screen.

3. Select the Load New Form button on the screen.

The selected form will open.

Enter information in forms
After a form is opened, enter data using the following methods:

Page View
Page View shows the form as it is printed.  WordMill Page View presents the form on the
screen as the government printed it.
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Toolbar

Form

Vertical scroll bar

Horizontal scroll
bar

 Screen image of form in Page View.

1. Use the mouse or the tab key to move between the blanks.  Use the scroll bars to
move the page up and down, and left and right on the screen.  The tab key moves
to the next blank.  The Shift + TAB combination moves to the previous blank.

2. Use the keyboard to enter the necessary data.

3. Use the Highlight Fields and Check for Blanks buttons on the toolbar to view the
blank fields on the form.

4. Select functions on the toolbar or menu items as necessary.

Speed Form
WordMill has created a series of computer screens called Speed Forms which allow the
user to quickly enter all data required in a particular form.  Speed Forms may only be
opened from within a Page View.

Follow these steps to use a Speed Form:

1. Press the Change View toggle button on the toolbar, or F3.

é

The following screen will appear.
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Speed Form

Screen Image of a Speed Form

1. Use the mouse or the tab key to move between the blanks.  Use the scroll bars to
move the page up and down, and left and right on the screen.

2. Use the keyboard to enter the necessary data.

3. Select functions on the toolbar or menu items as necessary.

4. Press the Speed Form/Page View button on the toolbar or F3 to return to the
Page View screen.
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Print a Completed Form
There are three methods which may be employed to print a completed form.

1. Select the Print button on the WordMill Toolbar while in the Page View.

or,

2. Press Shift + F7 on the keyboard.

or,

2. Select the Print Form option from the File category on the WordMill Menu while in
the Page View as shown below.

 

1. Enter number of copies or page range to print.

2. Press Print Setup to modify printer options (if necessary).

3. Press OK to begin the print job.
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Print a Blank Form
WordMill will print blank forms for use as worksheets or for completion by hand.  To print a
blank form, follow these steps:

Check the box
next to the form
you wish to print.

Select the Print
Blank Form button

1. Open WordMill or return to the Select WordMill Forms screen shown above.  (Use
the Forms button on the toolbar.)

2. Check the box adjacent to the desired form from the Select WordMill Forms
screen.

3. Press the Print Blank Form button.

Open a form related to an existing case
WordMill allows the user to access data already entered into the system.  Existing data is
recalled through the Search screen.

To view the Open Existing Record screen press the Search for Case button on the Select
WordMill Forms screen.  The Search screen is shown below.

(Data shown is from the USDC form library.  Other libraries will work with the same
principles.)

Search Screen

Choose sort type

Case records

Names of
Plaintiffs

Names of
Defendants

Date/Time
Added

Docket
Numbers

Search for data

To locate the desired case data and open a form with the desired data:
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1. Select the method WordMill will sort the case records.  Press one of the sort
option buttons.  The options (for this particular WordMill library) are as follows:

1. Date Added: 1. reverse sorts records by the date
information was added to the system.

2. Plaintiff: 2. sorts records alphabetically by the
name of the plaintiff.

3. Defendant: 3. sorts records alphabetically by the
name of the defendant.

4. Docket Number: 4. sorts records by the docket
number.

 Records are arranged across the screen.  Each row represents data from the
same record.

2. Click on the row containing the desired case record.  It will be highlighted by
WordMill.

 It may be necessary to scroll through the Search Screen.  Use the scroll bar to
move the list up or down.

3. Press OK.  This will return the user to the Select Forms Screen.  Any forms that
were accessed before with this case should now be highlighted.

4. Check the box(es) adjacent to the form(s) desired.

5. Press OK to open the form(s) with the selected data.

Forms related to subpoenaed or summoned parties will require the further
selection of data.  Follow the prompts on the selection screens to select the
existing data or add a new location or name to the record.

WordMill Toolbar
Toolbars contain buttons that give you quick mouse access to many commands and
features in WordMill.  For example, you can print a form by clicking the Print button on the
WordMill toolbar.

WordMill Toolbar

When you first start WordMill, the toolbar appears on the upper edge of the screen. You
can detach or reattach the toolbar by double-clicking on it. Delete the toolbar by clicking the
control box in the top left corner of the floating toolbar.  Display the toolbar by choosing
Show Toolbar from the View menu.

You can see a description of a toolbar button's function in a tool tip.  When you point to a
button with the mouse, the button's function will appear.

Show Fields
Use the Show Fields button on the WordMill Toolbar to toggle the color of the data fields
between gray and white.

Highlight Blanks
Highlight Blanks helps check work for completion. Use the Highlight Blanks button on
the WordMill toolbar to detect fields which do not have data entered.  WordMill looks to see
if any data has been placed in the field.  WordMill then highlights the empty fields by
shading the background a bright shade of yellow.

Note: WordMill only looks to see that a field has data of any sort in it.  WordMill has no
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ability to check to see that a field is completely or correctly filled in.

Copy Data
Copy Data makes an exact duplicate of all data that has been entered on the form.  This
may be useful for making a new case with information based upon an existing one.  When
this button is pressed, the data is copied and the user is shown a confirmation box that
reads "You are now editing a duplicate of this matter."

Save Defaults
Save Defaults takes a “snapshot” of the open form and all data that has been entered on
the form. Whenever that form is opened after the Save Defaults data has been pressed it
will appear with the data saved as default data.  This feature allows users to enter recurring
data such as their address or phone numbers once and then have them appear every time
a new form is opened.   The feature will ask whether the user desires to use the default
data each time a new form is opened.

To set defaults on any form, follow these steps:

1. Open the desired form.

2. Enter the data that is to be the default data.

3. Press the Save Default button or Shift + F9 on the keyboard.

Forms

The Forms button, or F5 on your keyboard, calls the Select Forms screen and allows the
user to open additional forms with the case data currently displayed in any open form(s).

Note: Pressing the Forms button opens additional forms with the same data record.  As a
result, any changes made to the data will be permanent for all forms using that record.

Text- & Text +
Use the Text- and Text + buttons, or F11 and F12 on your keyboard, to reduce or enlarge
the size of the font in the selected record.  Press the buttons repeatedly to step the size up
or down.  The font values will be saved for the current form, but it will not affect the size of
the same data in other forms.

Note:  While WordMill provides the user with the ability to reduce or enlarge the font, such
reductions may not be acceptable with the filing authority.  It is best to use these features
in moderation.
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Close & Save
The Close and Save buttons perform related functions.

The Close button, or F7 on your keyboard, prompts the user to save the current record
and then closes the active window.

The Save button, or F10 on your keyboard, saves all the data contained in the current case
record, but it does not close the window.

WordMill will prompt the user to save the data record when the close button is pressed.
However, as WordMill can determine if the user has modified the form since it was last
saved, it will not prompt the user to save the form's record when it has not been edited
since the last save event.

Undo
The Undo button, or Ctrl + Z, undoes the last action taken in WordMill.

Delete a Case Record
From time to time it may be necessary to delete records added inadvertently or records for
cases which are closed.  Select case records for deletion using the Open Existing Record
screen described above.  To delete a record, follow these steps:

 

Select row to be
deleted.

Press to delete the
row.

1. Open the Open Existing Record screen from the Select Forms screen.

2.  Select the record to delete.  (See Create form with an existing case above.)

3.  Press the button labeled Delete This Case or the Delete key on your keyboard.

4.  Follow the safety prompts to actually delete the case record.

Exit
Exit WordMill from the File -> Exit menu option.
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Connections
WordMill provides the user with the ability to access multiple data files.  This feature allows
a user to connect the forms in the program with any number of separate WordMill data
applications.

Moving data files and reconnecting

WordMill data files may be moved to a user-defined directory that is separate from the
WordMill program directory.  Use this feature when installing WordMill on a network or
when the user has established a directory system which requires isolation of data files.

As a safety precaution, WordMill does not provide the facility to disconnect and move the
data file.  Follow these steps to move and reconnect the data file.

1. Close all applications.

2. Use Windows to move the file named *DAT.WML from the WordMill directory to
the desired location.

3. Open WordMill.

 WordMill will detect that the file has been moved but does not have the ability to
locate the file.  It will prompt the user for the location of the file.

4. Browse to the file.

5. Press OK. WordMill will acknowledge the new connection.

Connecting to existing data files.

1. Close all WordMill windows.

2. Select Set Preferences from the File menu item.

3. Under ‘Path of attached case data file’, press the Change Path button

4. Press OK.

5. WordMill will indicate whether the connection was successfully completed or if
there was an error.  In the case of an error, determine the exact name and path of
the desired file and repeat the above steps:

Note:  WordMill data applications are specific to the form library and must be created by
the WordMill Setup program.
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About WordMill

Troubleshooting

Display errata
WordMill may appear to leave lines or graphic images out of documents viewed in Page View.  The cause
may be one of the following.

Normal Video Dropout

Video dropout may be a normal by-product of the interaction between WordMill and your video driver.  If the
form prints satisfactorily and the drop-outs are not interfering with use of WordMill,  you may wish to ignore the
drop-outs.

Memory

Video dropout may be a result of a lack of free memory which occurs from a variety of causes unrelated to
WordMill.  Free memory in your computer by closing applications and eliminating background processes and
restart Windows and WordMill.  Memory related video dropout is usually accompanied by corresponding
omissions on documents printed during the troubled session.  (Please see the discussion on memory in #2 of
Printing Errata).

Video resolution

Video dropout may be a result of the video resolution you have chosen for your computer.  Experiment with
different resolution settings to improve the clarity of your screen image.  Modify screen resolution settings with
the Windows Setup applet found in the Main Program Group.

Printing errata

Key Code

WordMill incorporates a key code to prevent unregistered users from printing completed documents.  WordMill
will query all users who have not previously entered the correct code on every startup to enter the key code.
To obtain this code, call 1-800-967-3645.  Filled forms printed without registering the program will be
embossed with the word ‘DEMO.’

Memory related printing errata

WordMill has worked well when installed on computers having 4 megabytes of RAM, however it is suggested
that users have at least 8 megabytes of RAM on the machine running WordMill.  However, having this amount
(or more) will not ensure the user of having sufficient free memory to run WordMill.  Other software packages
which are being run at the same time as WordMill may consume significant portions of the available memory
space thereby denying adequate memory to WordMill.  Please close other applications if you are experiencing
erratic behavior from WordMill.

A common problem with Windows memory allocation occurs when another program has "crashed" requiring
use of the Ctrl-Alt-Del bail-out.  While the offending program has been "removed" from view, it leaves a dead
zone of memory corruption. Please exit Windows and restart whenever a program crashes or behaves
erratically to ensure system and resource integrity,.

Drivers/Setup related printing errata

If you experience bizarre printing problems such as odd lines on the final forms you may be experiencing
driver problems.

We do not recommend using an ink jet printer with WordMill.  While some users have had success in
using these types of printers, they frequently do not support the margin areas required by government forms.

If your printer is a laser printer made by vendors other than HP and you experience printing difficulties,
load a standard HP III or HP IV printer driver and assign it to the same port as your current printer.  Most laser
printers are compatible with the HP drivers.  In case of difficulty, switch to the HP driver whenever you print
from WordMill.  To change printers, press the options button on the printers dialog box which appears
whenever you press the WordMill Print button.

All Windows software relies upon drivers to provide the interface between the software program and the
particular items of hardware which make up your "computer."  It is our experience that the drivers used for
printing or for video display may occasionally be incompatible with some functions of Windows software.  Your
video and printer driver and the screen resolution you are operating under have a direct connection to print
functions, and any one or combination of these may be the culprit.

If the latest drivers fail to solve the problem, switch to Windows default settings for printer and video.
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Technical Support
If all else has failed, please call WordMill to speak with a programmer.

1-800-WordMill (1-800-967-3645) or (504) 734-0005.
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I hope you enjoy using our product.

Sincerely,
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License Agreement

Terms
WordMill Inc., agrees to sell, and the Buyer agrees to buy, a license for use of this WordMill Form
Library under the following terms and conditions:

LICENSE

Title to the program, manuals, diskette(s), and documentation remains the property of WordMill Inc.
WordMill hereby grants a perpetual license for the use of the previously described items revocable only
if Buyer violates the terms of this agreement.  However, should a court determine that this transaction
was a sale of the program rather than a transfer of a license to use it, the parties hereby agree that the
following terms and conditions shall be construed as conditions of the sale.

WordMill will endeavor to periodically update the library to keep it current with the needs of the practice
and the requirements of the agency or courts issuing the forms and materials included in the WordMill
form Library.  WordMill reserves the right to require compensation for such updates or additions. The
terms of this agreement shall extend to all future releases, updates or upgrades unless specifically
changed by WordMill Inc.

For the purposes of this agreement the following definitions shall apply:

WordMill: Shall refer to WordMill Inc., a Louisiana Corporation, and shall include any and all acts by
WordMill Inc.'s officers and employees.

Program shall refer to all files, whether executable or not, which make up the WordMill Form Library.

TERMS

Buyer agrees not to do any of the following:

1. Copy the program for purposes other than backup or to run it from a computer's hard disk;

2. Run or install the program or component files on more than one machine at a time, nor install it in a
system such as a network that makes it available for use by more than one user or on more than one
machine at a time without specific agreement from WordMill Inc.

3. Rent the program to others.

4. Reverse engineer the program or its component files, which shall be considered trade secrets of
WordMill Inc., and are proprietary information.

5. Sell or rent component files of the WordMill Form Library.

6. Create a competitive program with a substantially similar "look and feel";

7. Alter the program or its component files.

Buyer may transfer this license to another.  However, Buyer must transfer all documentation and media
to the purchaser and may not retain copies of any published or electronic media containing the WordMill
Form Library originally purchased by Buyer.

Buyer hereby assumes liability for any breach of this agreement or of applicable public laws by the
transferee, unless Buyer conveys a written document reproducing the terms of this agreement signed by
the Purchaser and Buyer and including the terms of the sale to WordMill

WordMill has a copyright covering the programming and product produced by the WordMill Form Library
to the extent allowed by law.  WordMill hereby grants the Buyer the right to reproduce the product of the
WordMill Forms Library for purposes related to the internal operations of the Buyer's office or
professional practice.

LIMITED WARRANTY AND INDEMNITY AGREEMENT

WordMill hereby warrants the magnetic or published media on which the WordMill Form Library and its
accompanying documentation are published to be free from defect in material or workmanship for 90
days from the date of purchase.  WordMill will replace the diskette(s) or documentation if notified within
the warranty period.  Buyer's remedy is strictly limited to the replacement of such media.

WordMill supplies the program as a tool or aid to be employed in the professional practice of law or in
the course of dealing with government agencies or courts.  It is specifically understood that the Buyer
assumes all responsibility for the proper use, completion, and review of the program's output to ensure
that the documents and documents' content meets the professional or legal standards required for the
type of document(s)  produced, including, but not limited to: ensuring forms and instructions are current,
that all forms are properly completed, and that they are generally used in the proper manner. BUYER
FURTHER ACCEPTS ALL RESPONSIBILITY FOR ALL DAMAGES (if any) OCCURRING DIRECTLY
OR INDIRECTLY FROM THE USE OR MISUSE OF THIS PROGRAM AND/OR ITS ACCOMPANYING
DOCUMENTATION.

Due to the current state of the art of computer programming and the potential for incompatibility of
software and/or hardware combinations, WORDMILL DISCLAIMS ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WARRANTIES OF MERCHANTIBILITY OR OF FITNESS FOR A PARTICULAR
PURPOSE, OTHER THAN THOSE STATED IN THE PRECEDING PARAGRAPHS.  BUYER'S
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REMEDIES FOR BREACH OF THE LIMITED WARRANTY ARE LIMITED TO THOSE STATED IN THE
PRECEDING PARAGRAPHS.  THIS LIMITATION SPECIFICALLY EXCLUDES AND PRECLUDES
RECOVERY OF DAMAGES OF ANY KIND.  This document is the parties' entire agreement.  No
representative of WordMill other than a corporate officer is authorized to alter these terms, and an
officer may only alter the terms of this agreement in writing.

GOVERNING LAW
In case of any dispute, this agreement will be governed by Louisiana law.  Copyright and Trademark
issues shall be governed by the applicable laws of the United States.
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Glossary of Terms
Case record

WordMill stores case data as a case record.  A case will have one record for each person
subpoenaed or summoned.

Data fields

Space on both Page View form and Speed Form where data may be entered.  View data
fields in Page View by pressing the Show Fields toggle on the WordMill Toolbar.

Key word

Code word corresponding to the reference code generated by an installation.  Entering the
proper key word will fully enable the WordMill form library.

Open WordMill

Run the WordMill software.

Page View

Editable representation of printed page.

Reference code

Code generated by WordMill software when WordMill is installed on a particular computer.
This code is unique to each computer that WordMill is installed on. Registered users may
present the code to WordMill at 1-800-967-3645 to receive the key word required to run a
full installation of the form library.

Scroll bars

Windows tools located at the right edge (vertical scroll bar) and bottom edge (horizontal
scroll bar) of the screen which allow the user to roll the contents of the screen in any
desired direction.

Search screen

Screen from which the user selects a saved case record to use when opening forms.

Toolbar

Collection of buttons which start the actions listed on their face when pressed.  The
WordMill Toolbar may be moved about the screen by clicking upon it and dragging it.  Fix it
to any edge of the screen by moving to the extreme edge of the screen.  Remove it
completely by clicking on the control box while it is in a floating mode.  Replace it with the
View Toolbar menu command.

WordMill form

Refers to the electronically stored copy of the original government document.  WordMill
forms do not contain the data they display, rather the form and the data are combined at
the time of viewing and printing.

WordMill session

A session refers to the period when a user has a particular case record "opened."
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